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Introduction 

 
Power*Log™(Petrographical Office Wellsite Evaluation and Reporting) is a chip and core logging management 
program that utilizes single-entry data capturing to produce geological striplogs. The geological data is entered into 
the system through the use of intuitive data entry forms to ensure standardization of data. This data is stored in an 
RDBMS(Relational Database Management System) to allow data manipulation using SQL access tools. 

Power*Log™ software consists of four (4) main parts: 

1.) A log editor module that allows you to change the striplogs to suit your needs and preferences. 
2.) A data transfer module. 
3.) Report printing modules. 
4.) An on-line help system that is designed to familiarize you with the commands and functions available in 

Power*Log™ and lead you through many of the processes involved in creating welllogs. 

A note about navigating through Power*Log™ Reports: 

When you are entering information into data forms, you may move between boxes/fields by pressing the Tab key 
to go forward and Shift +Tab keys to move backwards. To exit forms that do not have an Exit, OK, or Cancel 
button, press the Esc key on the keyboard. 

To access the On-line Help System in Power*Log™: 

You can make use of the context sensitive help by pressing the F1 key when you are in a dialogue box. A pertinent 
help file will appear, opened to the topic relevant to the dialogue box you are in. 

Below are some examples of common features within Power*Log™: 

The Toolbar 

 

The Selection Bar… 

 

The Status Bar… 

 
The Status Bar displays system status messages and any error message (associated with a field entry), in the far 
left corner. The KB elevation is displayed in the lower right corner of the Status Bar. 



Power*Log Tutorial 2018 
 

Metric Tutorial   Page 5 

Import Toolbar 

This toolbar is dockable and can be moved to different places on the screen. 

 

Export Toolbar 

This toolbar is dockable and can be moved to different places on the screen. 

 
RTF Font Toolbar 
Turns the RTF Font Toolbar on and off. This toolbar is dockable and can be moved to different places on the 
screen. This is used with the New RTF Annotations used on the Log. 

 

RTF Line and Boxes Toolbar 

Turns the RTF Line and Boxes Toolbar on and off. This toolbar is dockable and can be moved to different places on 
the screen. This is used with the New RTF Annotations used on the Log. 
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The On-line Help is divided into four (4) main categories: 
 
Commands - Descriptions of each menu command within Power*Log™. 
 
Toolbar - Shortcuts to common commands are explained. 
 
Database Table Operations - Commands/functions related to the Database Table are described. 
 
Quick Reference Guide - The portion of the On-line Help System, that quickly refers you to some of the more 
commonly performed tasks. 
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This tutorial will guide you through the process of creating and editing a new striplog (hereafter 
referred to simply as a log), with curves and interpreted lithology. 

Connecting to the Database 

1.) Double click on the Power*Log  Icon. Acknowledge the Security Information window by clicking on 

the  button. This will initiate the program and activate a Connect Database window. 

 
2.) Highlight the PGEOLOGY 2018 METRIC (Microsoft Access Driver[*.mbd])) database by clicking on it once. 
3.) Move your mouse pointer to the User ID field and click. This will activate a flashing cursor in the User ID field. 

Type “pgeology” in the User ID field. Press the Tab key on the keyboard to move to the Password field. 

4.) Type “pgeology” in the Password field and then click on the  button. The program will now load 
various dictionaries and then activate an Open Log window. 

Creating a new Well / Log 

1. The first step in creating a new log is to click on the  New Log button on the Toolbar or to select New 
under File on the Selection Bar. This will open the New Log window below. 

This more than likely will appear after connecting to the Database without you have to do the above procedure if 
this was the first time you have activated Power*Log. 

 
1.) The Well/Log Name field is where you enter the name of the well (no more than 50 characters long). Type 

“Tutorial Well” into the Well / Log Name field. 

2.) Click on the  button to activate the UWI Format window. 
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3.) You will be using the DLS (Dominion Land Survey System) format (for Alberta, Saskatchewan, Manitoba and 

some of BC). Enter the following information into the empty DLS fields and remember to Tab between fields. 
Loc. Ex.: 00, LSD: 14, Sec.: 32Township: 063, Range: 23, E/W: W, Mer.: 5, O/A: 0, Event Sequence: 0. 

4.) Click on the  button when you have finished entering the UWI. An extended UWI is created by 
Power*LogTM from the many small fields that you just filled in. 

5.) Click on the  button to activate the Log Format List window. 

 

6.) Click on “V SYSTEM Geology Log [SYSTEM (M)]” to highlight it and then click on the  button. 
You may also double click on “V SYSTEM Geology Log [SYSTEM (M)].” 

7.) Once you have been returned to the New Log window, double click in the Log Start Depth field. This will 
highlight the zero (0) and activate a flashing cursor. Type 1190 in the Log Start Depth field. 

8.) Once the information is entered, click on the  button. 
9.) This will initiate a New Log. During this process, the curves associated with the selected log format will be 

added. Drill Rate will be the first Add curve window. 
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10.) Click on the  button in the Add Curve window for Drill Rate. This will activate the second Add Curve 
window for Total Gas. 

 

11.) Click on the  button in the Add Curve window for Total Gas. This will activate well and it’s log layout 

You have just added two curves to the database that will be displayed as curve layers in the Drilling 
Progress track on the new Tutorial log showing the Tutorial Wells information. 

**When the log opens, it should resemble this log.** 
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12.) You can now fill in your pertinent well information by selecting Well under Edit pull down menu on the 
Selection Bar to activate the Well window. 

 
13.) Type In 24.9 the KB field with ad then fill in the information you feel is necessary (The well window shown 

above has been filled in to give you an idea of how to complete the fields) and then click on the  button 
to save any changes you have made to the database. 

Note: Some of the fields in the Well window have character restrictions or mandatory requirements. Consequently, 
if any of these restrictions have been violated or if any requirements have not been met, the offending field will be 
highlighted. The nature of the problem will be displayed on the Status Bar (lower left corner of the screen), and you 
will be prompted with a system error message window. 

14.) If the record has been successfully saved, click on the  button, when prompted with the Shortcut 
Options system window. 
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The System Options Window 

To activate the System Options window click on System Options under the Options menu selection. 

General Tab 

 

Home Directory - This is the directory on your hard drive where Power*Log, Power*Core and Power*Curve is 
being executed. The user will not see any symbols on their log or print out any of our reports it you have the wrong 
home directory. 

 This check box when  activated will populate the Open Log window with all the wells in the 
database. If it is unchecked it may help our corporate users and the time it take to retrieve thousands of wells from 
the database and to populate the Open Log window with that information. If this check box is deactivated and you 

wish to see all your wells then simply click on the  button in the Open Log window to see all their wells if 
this option is deactivated. 

Date Format - From this drop box, you can select the date format. This selection determines 
how every date in Power*Log / Core & Curve will be entered and displayed. If you import a log 
with different date formats, Power*Log / Core & Curve will change the dates to comply with the 
format you've chosen here. The user can change this at any time and all the Date formats will be 
changed in the database. 
 

Version Compatibility - Enables the user to achieve compatibility for Annotations in the older Versions of 
Power*Suite (V1.81 and before) and the Annotations in the newer Versions of Power*Suite (V1.9 and later). 
Data Buffer Lookahead - The number placed in this field determines how far ahead and behind the current top 
depth will be stored in the computers buffer. The larger the look ahead number, the longer it takes for Power*Log / 
Core & Curve to refresh the screen when you exceed the look ahead value. However, until you meet or exceed the 
look ahead value, scrolling will be much faster, because the database is not yet being accessed. 
Fonts Tab 
This tab allows the user to set up most of the fonts used in Power*Log, Core and Curve. You can set it up 
to be used on the current log as well as using the fonts as your defaults when you are making new logs. 
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Annotation Font - Allows you to determine the default font style, type, color and size of your annotations on your 
log, Also this is the default when you use any of the Sample Description Transfer options. 
Survey Font - Allows you to determine the font style, type, color and size of your survey data associated with the 
Survey Layer on your log. 
Bit Record Font - Allows you to determine the font style, type, color and size of your bit record data associated 
with the Bit Record Layer on your log. 
Generic Category Font - Allows you to determine the font style, type, color and size of your Long or Short Name 
display option in all the Generic Category Layers displayed on your log. 
Depth Font - This allows you to determine the font style, type, color and size of the depth markers in the Depth 
track of the log. 

 - These radio buttons allows the user to change the orientation of the Depth Font on the 
Layer. Beware you may have to change the Track Width to accommodate the Font size and orientation. Refer to the 
Log Configuration Builder to do this. 

 This check box  when activated will display the depth units with the depth on the Depth Layer. ie. 
1000 ft or 1000 m vs. 1000 
Track Header Font - Allows you to determine the font style, type, color and size of your Track Headers on your log. 
All track headers use the same font across the entire log. 
Layer Header Font - Allows you to determine the font style, type, color and size of your Layer Headers on your log. 
All Layer headers use the same font across the entire log. 
Formation Tops Font - Allows you to determine the font style, type, color and size of your Formation Tops data 
associated with the Formation Tops Long and Expanded Layers on your log. 
Offscale Font - Allows you to determine the font style, type, color and size of your curve values displayed when the 
curve pegs off scale.  
Core Box Font - Allows you to determine the font style, type, color and size of your Core Box data entered in the 
Core Box layer. 
Casing String Font - Allows you to determine the font style, type, color and size of your Casing string data 
displayed on the Casing String layer. This data is entered through the Casing String Report. 
Date Font - Allows you to determine the font style, type, color and size of your Date data entered in the Date layer. 
Core Sample Code Font - Allows you to determine the font style, type, color and size of your Core Plug data 
entered through the Core Plug Report. This font is displayed on the Core Sample Code layer. 
Sidewall Core Font - Allows you to determine the font style, type, color and size of your Sidewall Run and Sample 
Number data entered through the Sidewall Core Report. This font is displayed on the Sidewall Core layer. 
MDT Font - Allows you to determine the font style, type, color and size of your MDT Run and Test Number data 
entered through the MDT Report. This font is displayed on the MDT layer. 

 This check box  when activated will make the font setting in this window your defaults 
for any new log created regardless on the Fonts stored in the template. 
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Display Tab 

 

Arrowed Subintervals - This check box  when activated will indicate the top and bottom of your subintervals 
(portion of an interval) with an arrow rather than a set of symbols. An example is shown below. 

                     
   Normal Subintervals Arrowed Subintervals 
Transparent - This check box  when activated, this function makes the background of the accessory symbols 
transparent, so that the bed in the background shows through. If deactivated, a white background surrounds the 
accessory symbols in order to separate them more from the beds. 
Use Global Symbols – With the ability to edit existing metafiles the user may have imported a well that has used 
metafiles or symbols that have been modified to look differently than the one existing within your system symbols. If 
you wish to use your symbol set instead of the revised imported ones you can select this check box  to make that 
change. 
Interbed Line Display Type - This check box  when activated will display the interbed data with a line display 
splitting the two lithology types or when unchecked will display the lithology in an interbed fashion as displayed 
below. 
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Curve Backup fill – This check box  when activated will show a sideways hatching fill pattern when a curve goes 
off scale or in the backup mode. If unchecked there will be no hatching pattern when the curve goes off scale. 
Frequency @ 1:240 – This drop box determines how often symbols are drawn on a Lithology Layer, with the 
scale of 1:240. For example: 1 symbol every 1 meter at 1:240, 2 symbols every 1 meter at 1:120, 1 symbol every 2 
meters at 1:480, and so on. These frequencies are only in effect if you utilize the entire interval in Oil Shows, 
Rounding, Sorting, Framework, or designated an interval in Sedimentary Structures, Traces Fossils and Rock 
Accessories. 
Lithology Profile - This check box  when activated will fill in the Carbonate Texture and Grain Size layers with the 
interpretive lithology. It will draw the lithology to the maximum size filled in over the interval. 

Note: The user may wish to turn off the track borders when this option is selected. You will see an example of this 
shown below. 

 
Grain Size Scale List box - You may choose between Wentworth, Canstrat or Amstrat 
scales, when using the Grain Size Builder. The Wentworth Grain size only allows full grain 
size while Canstrat / Amstrat allow half grain sizes when drafting in the Grain size and matrix 
layers. 

 This  radio button will display the Grain Size Track header with the equivalent verbal grain sizes such 
as such as C slt, VF snd, F snd, M snd, C snd etc. 

 Verbal Scale    MM Scale     
 This  radio button will display the Grain Size Track header with the equivalent numeric grain sizes (in 

mm) such as .0625, .125, .25, .5, 1, 2 etc. as shown above. 
 This  radio button will display the grain size with strait edges and right angles between the grain sizes. 

The illustration below is shown with Lithology Profile activated. 

 Hard Edges        Soft Edges      
 This  radio button will display the grain size with curved edges and rounded angles between the grain 

sizes. 

Grain Size  This drop box allows the user to select a hatching pattern when 
using the Grain Size Layer with the Lithology Profile not activate. 
Grain Size  This color selector allows the user to pick the line color (foreground) when the 
fill pattern option is used. The background color is found in the Layer configuration for the Grain Size. 



Power*Log Tutorial 2018 
 

Metric Tutorial   Page 15 

    
 Grain Size No Pattern Hard edges Grain Size Pattern Soft edges 

Carbonate Texture  This drop box allows the user to select a hatching 
pattern when using the Carbonate Texture Layer with the Lithology Profile not activate. 
Carbonate Texture  This color selector allows the user to pick the line color (foreground) 
when the fill pattern option is used. The background color is found in the Layer configuration for the 
Carbonate Texture Layer. 
Carbonate Textures  This  radio button will display the grain size with strait edges and right angles 
between the Carbonate Textures. The illustration below is shown with Lithology Profile activated. 
Carbonate Textures  This  radio button will display the grain size with curved edges and rounded angles 
between the Carbonate Textures. 

-When this check box  is activated the bedding contacts (lines) between the 
drawn lithology types in the Interpretive Lithology Layer will be shown. 

 When this check box  is activated it will turn on the accessories in the 
Interpretive Lithology Layer. 
Monitor Height - This option allows you to scale your monitor for Power*Log / Core so you may correlate on-
screen wells with hard copy logs that you may have. It is recommended that you take an opportunity to measure the 
vertical viewing area of your monitor in inches and then insert that value in the Monitor Height field. Be aware, 
however, that if you adjust the screen height knob on your monitor, this will affect the monitor height setting. 
Monitor Width - This option allows you to scale your monitor for Power*Curve so you may correlate on-screen 
wells with hard copy logs that you may have. It is recommended that you take an opportunity to measure the 
horizontal viewing area of your monitor in inches and then insert that value in the Monitor Width field. Be aware, 
however, that if you adjust the screen width knob on your monitor, this will affect the monitor width setting. 

Note: You must restart Power*Log / Core & Curve for the Monitor Width / Height changes to take effect. 

This drop box option will display your directional surveys on your log in either 
Quadrant format N 62 º W) or Azimuth format (AZ 298 º) 
 

Display TVD check box  when activated will display the survey with TVD values 
Display SSL check box  when activated will display the survey with SSL values 

 This check box  when activated will display the Sidewall Core Run & Core 
numbers above the core triangle indicator on the Sidewall Core layer. 
Favorites Tab 
This tab allows the user to define their System favorites for all the data categories that support these choices. This 
tab dialogue also allows the user to access the % Lithology Sort order for the % Lithology Track. 

 

Rock Favorites - The  button when activated allows the user to determine the number of the activation 
of the Rock Type Builder window in the Interpreted and Detailed Lithology tracks. 
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1.) Click on the  button in the System Options window. 

2.) Click on the  button in the Rock Type Favorites list window to prepare it for the selection of your 
Rock Favorites. 

3.) Select the following Rock Types from the Rock Type Favorites list window: 
Anhy (prim) [Anhydrite (primary)] 
Sh m gy [Shale medium gray] 
Ss [Sandstone] 
Plus any other rock types you would use a lot. 

4.) Click on the  button to return to the System Options window. 
Accessory Favorites - Allows the user to determine their favorite Accessories and then displays them in a pop-up 

menu generated by the activation of the Accessory Builder window in the Interpretive 
Lithology track. 

1.) Click on the  button in the System Options window. 

2.) Click on the  button in the Accessory Favorites list window to prepare it for the selection of your 
Accessory Favorites. 

3.) Select the following Accessories from the Thinbed, Components, and Cement headings in the Accessory 
Favorites list window: 

Thinbed 
cht dk pebbles [chert dark pebbles] 
sh gy stringers [shale gray stringers] 

Component 
aren [arenaceous] 
fld grs [feldspar grains] 
pyric [pyritic] 
sac [salt casts] 
slty [silty] 

Cement 
sils [siliceous] 
Plus other components that you would use a lot. 

4.) Click on the  button to return to the System Options window. 

5.) Click on the  button to return to the Main Power*Log window. 

The Log Configuration Builder window 

 This is the heart of the Log/Track/Layer configurations and controls the way your well’s information is displayed 
on the log. 

 The well may have a lot of information stored in the database, but that information cannot be shown graphically 
on the log until the necessary layers are added to illustrate that information. 

1.) Click on Log Configuration Builder under the Options menu on the Selection Bar or click on the Log 

Configuration Builder  button on the Toolbar to activate window: 
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Fundamentals of the Log Configuration Builder Window 

The left side of the Log Configuration Builder window: Available Logs 

The Available Logs section or left side of the Log Configuration Builder window allows you to take any track or 
layer from Available Logs and add it to the log you are currently creating/building. On the left side of the window, 
below the  radio button is a list of the tracks available for adding to the Active Log. 

The Available Logs section or left side of the window contains the track and layer configuration of the SYSTEM 
[SYSTEM] log, when the window first opens. You have the option of using any of the existing Tracks and their 
associated layers or any of the existing Layers that are associated with any of the system logs in the log database. 

The user can click on the  button on the left side of the screen to activate a selection list of all 
log formats that are in your database. The list is comprised of two names with the first name in the list being the 
system Log Name and the second name (in brackets), being the UWI of its primary well. Double click on the log 
format you wish to copy from. 

Below the  radio button, on the left side of the window, is a list of the layers available in the track 
highlighted above. They will be added all at once, if you add their parent track. However, they can also be added on 
an individual basis, if you only want to add one layer to an existing Active Log track. 

The right side of the Log Configuration Builder window: Active Log 

The Active Log section or the right side of the window displays the tracks and layer configuration of the Active 
Log (the log you are currently creating), in the main Power*Log window. The name of the log is viewed in the Log 
field. In this case, it will be “Tutorial Well.” Below the  radio button on the right side of the window, is a list 
of the tracks that are currently found within the Active Log. The track at the top of this list is drawn on the left side 
of the log, while the track on the bottom of the list is drawn on the far right of the log with all of the other tracks 
drawn in between, respectively. Below the  radio button on the right side of the window, is a list of the 
layers that are associated with the track highlighted above. 

The middle of the Log Configuration Builder window: Selection Buttons 

The selection buttons, found in the middle column of the window, are for adding layers or tracks from the 
Available Logs to the Active Log, activating/deactivating the Active Log’s tracks, deleting active log tracks or 
layers, and moving tracks or layers within the Active Log itself. Step-by-step instructions for accomplishing these 
tasks are provided on the following pages. 

Working with the Log Configuration Builder Window 
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Deleting the Date and the Framework tracks on the Tutorial Log… 
1.) Highlight the Date track on the right side of the window by clicking on it. 

2.) Click on the  button. This action will prompt you with a system message, “Do you want to delete 

the selected track in your log?” Click on the  button. The Date track has now been removed from 
the Tutorial Log. 

3.) Highlight the Framework track by clicking on it once. 

4.) Click on the  button. This action will prompt you with a system message, “Do you want to delete 

the selected track in your log?” Click on the  button. The Framework track has now been 
removed from the Tutorial Log. 

Adding a Slide - Rotate Track to the Tutorial Log 
1.) On the left side of the Log configuration window scroll down the list of tracks and click on the Slide - Rotate 

track. The track will become highlighted and the  radio button will become activated. 
2.) On the right side of the Log configuration window click on the Depth Track. The track will become highlighted 

and the  radio button will become activated. 

3.) In the middle of the Log configuration window click on the  button. This will activate a System 
Message asking the user “ Do you really want to ADD the selected (track) from the available log to the active 
log?” 

4.) Click on the  button. This will activate a Get Name window asking the user to name the track. 

5.) The user may change the name or accept the Slide - Rotate as a name by clicking on the  button 
and the track will be added above the Depth Track or to the left on the vertical log. 

Resizing a track… 
1.) Scroll down the tracks list, on the right side of the Log Configuration Builder window and click on the 

Lithology Description track. 
2.) Double click in the Track Width field (2.24) and Type in the new value of 2.5 Then, press the Tab key and 

the total width of the log itself will change to reflect the increase in the width of the Lithology Description track 
as well as the Log width field. 

Note: For paper 8.5” wide, 8.00” is the widest that you want your log to be, especially if you are printing out the log 
in the Portrait paper orientation. 

Moving the Oil Show track… 
1.) Scroll down the tracks list, on the right side of the Log Configuration Builder window, and click on the Oil 

Show track to highlight it. 

2.) Click on the  button and it will change to “ .” Then, click on the Lithology Description 
track. The Oil Show track will then be placed above the Lithology Description track (to the left of the 
Lithology Description track on the actual log). 

Deleting the Bit Record layer from the Drilling Progress track… 
1.) Scroll up through the tracks list, on the right side of the Log Configuration Builder window, and click on the 

Drilling Progress track to highlight it. Notice that the layers associated with this track are displayed below, in 
the Layers list box. 

2.) Highlight the Bit Record layer, in the Layers list box, by clicking on it once. Notice that the  radio 
button is automatically activated by highlighting a given layer. 

3.) Click on the  button. This action will prompt you with a system message, “Do you want to delete 

the selected layer in your log?” Click on the  button. The Bit Record layer has now been 
removed from the log 

Turning off a track… 

1.) Scroll down the tracks list, on the right side of the Log Configuration Builder window, and click on the Test 
track. 

2.) Click on the  button to turn the “Y”(yes), to the left of the track name, to “N”(no), indicating that the 
track will not be shown on the log, until it is reactivated. 

3.) Alternatively, you can simply double click on the Test track to turn the “Y”(yes) to “N”(no). The user will notice 
the log width has now decrease in size from 8” to 7.8” wide. 
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Resizing and Configuring the Drilling Progress Track 
1.)  Scroll up the tracks list, on the right side of the Log Configuration Builder window, and then highlight or click 

on the Drilling Progress Track. 
2.)  Double click in the Track Width field (2.25) and Type in the new value of 2.45. Then, press the Tab key and 

the total width of the log itself will change to reflect the increase in the width of the Drilling Progress Track as 
well as increase the Log width field to 8”. 

3.)  Click on the  button (to the right of tracks), to activate the Track Configuration window. The 
changes in step four have already been done in this example. 

 
4.)  We will change the first Heading field. In the first heading field, Type in the well name “Tutorial Well.” In the 

Second heading field, Type in the location for the Tutorial Well, “14-32-63-23 W5M.” This would be beneficial if 
you were faxing or printing to Adobe the log only. It would identify to the client the location of the well data that 
is being transmitted. 

5.)  Click on the  button to save your changes 
6.)  A system message will appear asking the User. “Record saved successfully. Do you wish to exit?” Click on the 

 button. This action will return you to the Log Configuration Builder window, where you will see 
the new name of your track displayed on the log you are creating. Later, when you exit from the Log 
Configuration Builder window, you will notice that the track headings have conformed to your changes. 

7.)  Press the Esc key on the keyboard or click on the  button to exit from the Log Configuration 
Builder window. You will be returned to the main log window, where you will see the changes you have made 
to the new log. 

Importing ASCII File Data into the Drill Rate & Total Gas curve layers: 

1.)  Click on the File pull down menu, select Import and then select ASCII from the pop out menu. OR the user 

can select the  Icon from the Import Tool Bar. This will activate an Open ASCII Data File window. 

 

2.)  Navigate to the C:\Powersuite_2018\system folder and select the Metric Vertical ASCII TG & ROP 

curve.txt file. Click on the  button. Once the file has been selected, the Set delimiter window will 
be activated. 
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3.)  This file is a Space delimited file and the default on this window is space delimited. You will see <column 

break> between the data points. Click on the  button. This will open the Import window. 

 

4.)  The default on the Depth column is Column 1 is indicated by the purple X. In our case the depth is the first 
column so we do not have to change the depth column indicator. 

5.)  Click on the Column 2 on the left side and drag it to the Total Gas Curve layer on the right side of the 
window. You will see Column 2 in the mapped Data field and an APPEND in the action field. 

6.)  Click on the Column 3 on the left side and drag it to the Drill Rate Curve layer on the right side of the 
window. You will see Column 3 in the mapped Data field and an APPEND in the action field. 

7.)  Click on the  Button. This will import the curve data and prompt you with a database message saying 
Imported successfully. 

 

8.)  Click on the  button to close the window. 

9.)  Click on the  button to close the ASCII Import window. 
Changing Curve Scales 
1.) Click anywhere in the Drilling progress track to make it active. It will have a green outline. Go to the layer 

selection list and select drill rate layer from the list to make it the active layer. 
2.) Right click anywhere within the Drilling Rate track (Drill Rate Layer) to activate the pop-up menu. 



Power*Log Tutorial 2018 
 

Metric Tutorial   Page 21 

      
3.) Select Scale from the pop-up menu to activate the Curve Scale window for the Drill Rate curve. In this figure 

the user will notice the Scale has already been changed. 
4.) Notice that the default scale (when the curve was originally added to the log), was 0 to 15 min/m, as you would 

see in your window. To change the original scale from 0 – 15 min/m to 0 - 30min/m, simply adjust the Right / 
Top Scale value to 30 by double clicking in the Right Scale field and typing in a value of 30. 

Note: The backup scale (in this case straight shift), is there in case the curve values go off-scale (more than 30 
min/m). A straight shift backup scale for an original scale of 0 to 30min/m would be 30 to 60min/m for Left and 
Right Scale values, respectively. 

4.) Click on the  button and select  from the ensuing Shortcut Options window. 
**Your log should now look like the log below.** 
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Adding Sample Descriptions 

1.)  Click on Sample Description, under Reports on the Menu Bar to open the Sample Description window. 

N.B. The way the data entry windows work is that we will always open the data entry window with the deepest 
record entered for that record set. If you want to change that record then you can modify it and then click on the 

 button. But, if you want a new record remember to always click on the  button. If you do forget to click on 

the  button and change the record and you have not saved yet you can click on the  button. Then click 

on the  button and proceed with entering the new data record for that data entry window. 

 

2.) Type 1190 into the Interval (From) field and press the Tab key. 
3.) Type 1199 into the Interval (To) field and press the Tab key. 
4.) Type Anhy into the Rock Type / Heading field and then press the Tab key 4 times to get to the short 

description field. 

Note: The rock types have to be typed in correctly in the Short form field (according to our Geological Expansion 
Dictionary) in order for the Rock Type to be filled in when the Enter key is depressed. 

5.) Type the following description into the Short Description field, exactly as it appears below: 
wh, lt gy, crpxl, com sacs, sft, dns, ns. 

Note: The Short or Long Descriptions can be transferred to the Lithology Description layer and only the Long 
Description will be printed out in the Sample Description. 

6.) Select the Automatic Transfer, Transfer Depth Range and Transfer Short Form check boxes ( ), as 
shown in the preceding sample description window. 

7.) Click on the  button and then select  from the ensuing Shortcut Options window. You 
will see your sample description on the log at 1190m with the options selected in step 6. 

 Adding another Sample Description to the same interval… 

1.) Type Sh into the Rock Type field, tab 4 times and Type the following description into the Short Description 
field: 

lt gy, wxy, bentic, occly slty, tr aren grs, sft, blky. 
2.) Deselect Transfer Depth Range check box . 

3.) Click on the  button and then select  from the ensuing Shortcut Options window. Your 
description will now be viewed at 1191m. 
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Note: If you have made any typing errors the user can click on the  button, then you can make any 

necessary corrections and then  the record once again to replace the old record with the new one. 
 Adding another Sample Description to a new interval… 

1.) Click on the  button to advance the description interval from depth to 1199. Type in a new depth to 
1204. 

2.) Type Ss into the Rock Type field, tab 4 times and then Type the following description into the Short 
Description field: 

wh, lt gy, vf - f gred, w srt, sbang, qtz, tr wthrd fld grs, sils cmt, p intgran por (3-7%), sl tr 
ptch brn o stng, dull yel flor, fr stmg mky yel cut flor. 

3.) Select Transfer Depth Range check box . 

4.) Click on the  button and then select  from the ensuing Shortcut Options window. You 
will see your description at 1199m. 

 
 Adding more Sample Descriptions to a new interval… 

1.) Click on the  button to advance the description interval from depth to 1204. Type in a new depth to 
1209. 

2.) Type Ss into the Rock Type field, tab 4 times and then Type the following description into the Short 
Description field: 

wh, lt gy, vf - m gred, modly w srt, sbang, qtz, tr wthrd fld grs, tr dk cht pbls, sils cmt, fr 
intgran por (6-10%), q brn o stng, no cut flor. 

3.) Deselect Transfer Depth Range check box . 

4.) Click on the  button and then select  from the ensuing Shortcut Options window. You 
will see your description at 1204m. 

 Adding our Last Sample Descriptions utilizing the Auto Next button… 

1.) Click on the  button to advance the description interval from depth to 1209. Type in a new depth to 
1213. 

2.) Type Sh into the Rock Type field, tab 4 times and then Type the following description into the Short 
Description field: 

m - dk gy, micmica, v carb, calcs, fis. 
3.) Deselect Transfer Short Form check box . 

4.) Click on the  button and then select  from the ensuing Shortcut Options window. You will see 
your description at 1209m. 
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Printing out Sample Descriptions to Word. (Only if you have Word for Windows) 

1. Click on the  Print Reports to 
Word button on the Toolbar or 
select  Print Reports to Word 
Selection, under the File menu, on 
the Selection Bar to activate the 
Power*Log Report: Well End 
Report window. 

2. The Reporting Tool print window will 
automatically default to the active 
Well/Log Name. You will see 
Tutorial Well in the Choose a Well 
field If it is not the defaulted well then 
go to the Well list drop box and select 
it from the List. 

3. Highlight Sample Desc in the 
Reports field by clicking on it once. 

4. Leave the Depth Range field blank to 
print all the descriptions. 

5. Click on the 
check box 

6. Click on the  button in the Well End Report window to 
printout the Sample Descriptions. This will activate you word program and you will get the Sample 
descriptions and Formation tops that were input through the Reports window. 

7. When you are finished, press the Esc key on the keyboard to exit from the Well End Report window and to 

activate the following system message, “Do you want to save the setup”  Clicking on the  
button and the window selections you have just made will be remembered for the next time. Clicking on the 

 button will remember the default selections that were set for this window. 

Printing out Sample Descriptions (If you don’t have MSWord.) 

1.) Click on the  Print Well End Report button on the Toolbar or select  Print Well 
End Report, under File, on the Selection Bar to activate the Power*Log Report: 
Well End Report window. 

2.) The Well End Report print window will automatically default to the active Well/Log 
Name and its associated UWI: you will see Tutorial Well (100143206323W500) in 
the Well List field and it should be highlighted. If it is not highlighted, move the 
mouse pointer to the Well List field and click on the desired Well / Log Name to 
highlight the Well you wish to print information from. 

3.) Highlight Sample Descriptions in the Reports field by clicking on it once. 
4.) Select Printer from the Output drop box field list. 

5.) Click on the  button, in the upper right corner of the Well End Report 
window, to activate the Print Setup window. Notice that the currently selected printer 
is listed beneath the Default printer radio button , at the top left of the Print Setup 
window. Use the Printer section of the Print Setup window to specify the use of a 
printer other than the default printer. 

Note: Power*Log™ automatically defaults to a Paper Orientation of Portrait and a Paper Size of 8 5 x 11, as 
specified in the Orientation and Paper sections, respectively, of the Print Setup window. Please do NOT change 
these default settings. 

6.) Make sure that the All check box , in the Sample Description section at the lower right of the Well End 
Report window, is activated. 

7.) Click on the  button in the Well End Report window to printout the Sample Descriptions. 
8.) When you are finished, press the Esc key on the keyboard to exit from the Well End Report window and to 

activate the following system message, “Do you want to save the setup configuration?” Click on the 
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 button and all of the printer selection/settings information utilized in the Well End Report window 

will be saved to the database for any future Well End Report print jobs. Clicking on the  button will 
also return you to the main log window. 

Drawing Interpreted Lithology 

Note: To work on any layer in any track, simply double click on the track in which you wish to work to activate the 
“builder” window for that particular layer. Once the “builder” window for a given layer is active, you are then able to 
access the pop-up menu [right click] associated with that “builder” window and may proceed to enter any 
necessary intervals and graphical descriptions for the given layer. 

 Drawing Rock Types… 

1.) Double click anywhere within the Interpreted Lithology track to activate the Rock Type Builder window and 
the Toolbox with your Favorites Rock Type List. 

 

2.) The user can move the Tool Box to a position where it is out of the way by clicking and dragging the Tool Box 
menu bar. 

Note: The graphical images utilized in the Tool Box window represent specific Rock Types selected by the user in 
the System Options window (See System Options earlier in this tutorial). The written descriptions of the Rock 
Types illustrated in the above diagram were included as a visual aid and do not normally accompany a pop-up 
menu. 
3.)  Select the Rock Type for Anhydrite (primary) from the Tool Box window and it will automatically be displayed 

in the Rock Type field within the Rock Type Builder window. 
4.)  Define the top interval by clicking and holding the left mouse button at 1190m on the Interpreted Lithology 

track. 
5.)  Define the bottom interval by dragging the mouse pointer to 1199m on the Interpreted Lithology track. 
6.)  Release the mouse button and the interval will be drawn accordingly. 

 Drawing another Rock Type… 

1.)  Select  the Rock Type for Sandstone from Tool Box window and it will automatically be displayed in the Rock 
Type field within the Rock Type Builder window. 

2.)  Define the top interval by clicking and holding the left mouse button at or close to ( if the  is 
activated) 1199m on the Interpreted Lithology track. 

3.)  Define the bottom interval by dragging the mouse pointer to 1210m on the Interpreted Lithology track. 
4.)  Release the mouse button and the interval will be drawn accordingly. 

Note: If you happen to do something wrong remember you have an UNDO under the Edit Menu selection. Also 

there is an  button on the Toolbar. 

And another... 

1.)  Select the Rock Type for Shale (medium gray) from the Tool Box window and it will automatically be 
displayed in the Rock Type field within the Rock Type Builder window. 

2.)  Define the top interval by clicking and holding the left mouse button at 1210m on the Interpreted Lithology 
track. 

3.)  Define the bottom interval by dragging the mouse pointer to 1213m on the Interpreted Lithology track. 
4.)  Release the mouse button and the interval will be drawn accordingly. 

Note: You may wish to resize a particular bed or lithological interval, but remember that beds cannot completely 
overlap one another. Also, keep in mind that only the top or the bottom of a particular bed can be resized at any one 
time. Accordingly, if you wish to resize both (top and bottom), you will have to do it twice. 
 Resizing an interval… 
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N.B. If you have the  checked and your mouse pointer accuracy is 1 you must uncheck the check box 
to resize the following bed or decrease the mouse pointer accuracy. 

1.) Press and hold the Ctrl key on the keyboard down, while hovering over the bed boundary between the Shale 

and Sandstone bedding contact at 1210m. You will view a mouse pointer turn into resize arrow  and if the 
shale is viewed in the builder click and drag the left mouse button up one meter to 1209m on the 
Interpreted Lithology track. 

2.) Release the mouse button at 1209m, followed by the release of the Ctrl key on the keyboard, and you will be 
prompted with the following system message, “Do you really want to resize the interval from 1210.00 - 
1213.00 to 1209.00 - 1213.00?” 

3.) Click on the  button. 
4. Press the Esc key on the keyboard to exit from the Rock Type Builder window. 

Deleting a Single Rock Type or Bed 

1. Right click anywhere within the Interpreted Lithology track to activate the pop-up menu. 
2. Click on Delete and the following system message will be activated, “Do you really want 

to DELETE _ to _ ?” Click on the  button to confirm the deletion. 
3. Press the Esc key on the keyboard to exit from the Rock Type Builder window. 

Deleting Multiple Rock Types or Beds 

1. Hold the SHIFT Key down and then click and drag anywhere within the Interpreted Lithology track and 
then let go of the Shift Key and left mouse button. This will activate a Delete Intervals message box. 

 

2. Click on  button and the Intervals dragged over will be deleted. 

Note: When you delete a Rock Type, you will also delete its associated bed restricted rock description information, 
i.e. Grain Size, Porosity Grade, Type, Oil Show and all other bed restricted data. 

3. Press the Esc key on the keyboard to exit from the Rock Type Builder window. 
**Your log should now look like the log shown below.** 
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Editing Sample Descriptions 
1.) Make the Lithology Description layer active (in the Layer Selection List field), by clicking once anywhere 

within the Lithology Description track to highlight the Lithology Description track in green. 

 
Moving a Sample Description 
1.) Click anywhere within the Shale description that is viewed on your log at 1209 m to activate the RTF Font 

and RTF Line and Boxes toolbars and highlight the text. 
2.) Move the mouse pointer to the outline and you will see the pointer turn into a  crosshair. Click and drag 

your mouse to move the description down 2 meters to 1211m. 
3.) Click outside the annotation to save your annotations. 
Editing Sample Descriptions 
1.) Now we will edit the Shale description at 1192m. Click in the Sh description at 1192. You will see the 

description outlined on the log. 
2.) Move the mouse pointer to the outline and you will see the pointer turn into a  crosshair. Click and drag 

your mouse to move the description down 2 meters to 1194m. 
3.) Move your mouse pointer in the text field and click between the Sh and the (:) colon and Type in lam. 
4.) Click outside the annotation to save your annotations. 

 
Overview of RTF Font Toolbar buttons. 

At the flashing cursor or with some text highlighted this button will activate a Font Dialogue window to 
change Font Type, style, size etc. 

 At the flashing cursor or with some text highlighted this button will activate a Bold Font style. 

 At the flashing cursor or with some text highlighted this button will activate an Italic Font style. 

 At the flashing cursor or with some text highlighted this button will activate an Underline Font style. 

 At the flashing cursor or with some text highlighted this button will activate an Strikethrough Font style. 

 At the flashing cursor or with some text highlighted these buttons will orient the text line or paragraph 
left, centered or right within the box outline. 

 At the flashing cursor or with some text highlighted this button will place a bullet at the start of the text line or 
paragraph. 

 At the flashing cursor or with some text highlighted these buttons will indent or tab the text line or 
paragraph either left or right. 
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 At the flashing cursor or with some text highlighted this button will activate a new Font color. 

 At the flashing cursor or with some text highlighted this button will activate a Font background color. 

 
Overview of RTF Lines and Boxes Toolbar buttons. 

 Left Right Centered Text boxes: With the text box or annotations outline activated these buttons will 
orient the text box left, centered or right within the track borders. The user can also click and drag on the box outline 
to any orientation on the track which will override these buttons. 

Display scale drop box: This allows the user to change the display scale for each annotation to adapt 
to the printed or viewing scale of the log. The All Scales selection will display the annotation at all 
viewing and printing scales from 1:1 to 1:5000. If you select a different display scale then the 
annotation will be viewed at that viewing and printing scale and smaller. Anything larger than the 
display scale and the annotation will not be viewed or printed. This should alleviate the annotations 
overlapping each other when printed out on different scales. For example if the user were to choose 
1:120 the annotation would show up on viewing / printing scales from 1:120 to 1:5 and not show up on 

scales from 1:121 to 1:5000. 

Line Style Selector and Line Thickness drop boxes: These drop boxes allow the user to 
select a different line style for their drawn line as well as the line thickness for the line that is 
associated with each individual annotation. You can only have one line per annotation. The line 
can only be redrawn and not moved. 

 This button will show / hide the text for a particular annotation. The text will not hide itself until the annotation is 
clicked outside of or deselected. 

 This button will show / hide the line for a particular annotation. 

 This button will show / hide an outline around the annotation. The grey box you see around all annotations will 
not be printed. Only when this button is activated will the box be printed. 

Will show / hide an arrow pointer at the end of a line draw.  

 Will show / hide an arrow pointer at the start of a line draw. 

 Will show / hide a tail at the end of a line draw. 

 Will show / hide a tail at the start of a line draw. 
5.) Click outside the annotation to save your annotations. 
6.) One should not have to worry about the alignment when moving the annotations. Once you finished the moves 

Right Click on the Lithology Description layer to activate the pop out menu and Select the Resize to Track 
Selection. This will activate a System message shown below. 
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7.) Click on the  button. This will refit the annotations to align with the track edges. 
**Your log should now look like the log below.** 

 

Drawing Porosity (%) 

1.) Double click on the Porosity (%) track to activate the Porosity Builder window. 

 
2.) Double Click the mouse pointer (with the  check box activated) between 1199.00 and 1209.00m 

@ [5%]  and the entire interval will be drawn accordingly in purple to represent an entire interval. 
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3.) Click and drag the mouse pointer from 1209.00 [8%] to 1204.00 , release the mouse button, and the 
desired Porosity Grade will be drawn accordingly in green to represent a subinterval. 

Note: The mouse pointer does NOT have to be dragged to the same percentage (%) point at the bottom of the 
interval, as you selected at the top of the interval: the mouse pointer needs only to be dragged to the desired depth. 
4.) Click on the  check box to give your porosity grade a hand drafted effect. 

 Deleting Porosity (%)  Entire or Subinterval… 

If you wish to delete a Porosity (%) subinterval or entire interval, while the Porosity Builder window is open, right 
click within the interval slated for deletion to activate a pop-up menu, and then left or right click on the 
appropriate selection. 

 

Drawing Grain Size 

1.) Double click on the Grain Size track between to activate the Grain Size Builder window. 

 
2.) Using the left mouse button, click and drag the mouse pointer from 1199.00 [vf snd] to 1209.00 [f snd] 

 on the Grain Size track. 

Note: Measured Depths and Grain Sizes, like 199.00 [vf snd], can be viewed within the mouse pointer display 
box, situated just to the right of the mouse pointer. 

3.) Release the mouse button and the entire Grain Size interval will be drawn accordingly in purple to represent an 
entire interval. 

 Drawing a Grain Size Sub-Interval… 

1.) Using the left mouse button, click and drag the mouse pointer from 1209.00 [vf snd] to 

1204.00 [m snd] . 
2.) Release the mouse button and the Grain Size Sub-Interval will be drawn accordingly in green to represent a 

subinterval. 

 
3.) Click on the  check box to give your grain size a hand drafted effect. 
4.) To exit from the Grain Size Builder window and return to the log, press the Esc key on the keyboard once. 

Note: If you happen to do something wrong remember you have an UNDO under the Edit Menu selection. Also 

there is an  button on the Toolbar. 
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Drawing Oil Shows 

1.) Double click on the Oil Show track between to activate the Oil Show Builder window. 

 
2.) Right click anywhere within the Oil Show interval to activate the pop-up menu. 

 

Note: The symbols utilized in the pop-up menu, represent a specific percentage (%) or amount of oil staining, as 
illustrated in the above diagram. 

3.) Select 0-25% oil staining from the Sub Interval pop-up menu. 

4.) Click and drag your mouse pointer from 1199m to 1204m  and this sub-interval will be populated with 
the 0-25% oil staining symbol . 

5.) Right click anywhere on the Oil Show track to activate the pop-up menu. 
6.) Click on the Sub Interval selection and then select questionable oil staining from the list. 

7.) Click and drag your mouse pointer from 1204 to 1209m  and another 5m sub-interval will be populated 
with the questionable oil staining symbol. 

Drawing Sorting 

1.)  Double click on the Sorting track to activate the Sorting Builder window. 

 
2.)  Right click anywhere within the 1199m to 1209m Sorting interval to activate the pop-up menu. 

 

Note: Each of the abbreviations utilized in the pop-up menu represent a specific degree of Sorting. 

3.) Select w for the Entire Interval from the pop-up menu and the entire bed will be populated with the “W” 
symbol. 

 Drawing a Sorting sub-interval… 

1.) Right click anywhere within the Sorting Track to activate the pop-up menu. 
2.) Select modly w from the Sub Interval pop-out menu. 
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3.) Click and drag your mouse from 1204 to 1209m  and one 5m sub-interval will be populated with the 
“mW” symbol. 

Drawing Rounding 

1.) Double click on the Rounding track to activate the Rounding Builder window. 

 
2.) Right click anywhere within the 1199m to 1209m Rounding interval to activate the pop-up menu  

 
3.) Select sbang for the Entire Interval from the pop-up menu and the entire bed will be populated with the “a” 

symbol. 

Drawing Porosity Type 

1.) Double click on the Porosity Type Track to activate the Porosity Type Builder window  

 
2.) Right click anywhere within the Porosity Type track activate the pop-up menu and then select types to 

activate the pop-out menu. 

 
3.) Select x from the pop-up menu and click at 1200m, 1202m 1205m and 1208m and “x’s will appear at those 

depths. 

Note: If you happen to do something wrong remember you have an UNDO under the Edit Menu selection. Also 

there is an  button on the Toolbar. 

Drawing Slides on the Slide / Rotate Track 

We can also import the slides and Toolface orientation but for this example we will do this manually. In the 
Power*Curve tutorial we will import the slides from a *.txt file. 
1.) Double click on the Slide - Rotate Track to activate the Slide – Rotate Builder window  
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2.) Click and drag your mouse within the track from 1191 to 1197m  and then 
let go. The slide will automatically be drawn for you with an S. 

3.) To enter the Toolface orientation click on the slide that you just dragged in and 
then type 120 in the Toolface field and then click on the Right radio button. 

4.) Click on the  button. 
5.) To change the font orientation from the default Horizontal on the slide right click on 

the Slide you just modified with the Toolface to activate the pop out menu and 
select the Vertical Orientation. 

6.) To RESIZE an interval you would hold the CTRL key and mouse over an end point 

of a slide to turn the mouse pointer into a resize arrow  click and drag your mouse to a new depth interval 
drawn. OR Click on the interval to place its attributes into the builder and then type in a new start or end 

depth and then click on the  button. 
7.) To DELETE right click on the drawn interval and select delete from the pop-out menu. 

Drawing Accessories 

Using the log on page 34 as a guideline, add some Accessories to the log at your discretion. Listed below are the 
steps for adding Accessories: 
1.) Double click anywhere within the Interpreted Lithology track to activate the Rock Type Builder window. 

    
2.)  Right click anywhere within the Interpreted Lithology track to activate the pop-up menu. 
3.) Select Acc Builder from the pop-up menu to activate the Rock Accessory Builder window or click on the 

 button in the Rock Type builder. 
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4.)  Now the user can move the Toolbox Favorite List by clicking and dragging the menu bar to a convenient 

location. 

Adding a Thinbed… 

5.) Click on the symbol for Shale Gray Stringers from the Tool Box Favorites list, right click favorites list, or in 
the Thinbed field in the Rock Accessory Builder window will be filled in with sh gy stringer [shale gray 
stringers]. 

6.) Click anywhere within existing Interpreted Lithology to insert the desired Accessories. 

Adding another Thinbed… 

1.) Click on the symbol for Chert Dark Pebbles] from the Tool Box Favorites List and the Thinbed field in the 
Rock Accessory Builder window will be filled in with cht dk pebbles [chert dark pebbles]. 

2.) Click along the bottom of the Sandstone interval to insert the desired Accessory. 

Note: When placing Accessories on the log, you may wish to increase the mouse accuracy from the default of 1 
to 0.1. This selection box is located to the left of the LAS button on the Toolbar. 

Adding an Accessory… 

1.) Click on the symbol for Salt Casts from the Tool Box Favorites List and the Component field in the Rock 
Accessory Builder window will be filled in with sac [salt casts]. 

2.) Click anywhere within the Anhy (prim) interval to insert the desired Accessory. 

Adding another Accessory… 

1.) Click on the symbol for Silty from the Tool Box Favorites List and the Component field in the Rock 
Accessory Builder window will be filled in with slty [silty]. 

2.) Click within the Anhy (prim) interval to insert the desired Accessory/Accessories. 

Add the following an Accessory and Grains… 

Arenaceous  Feldspar Grains 

Adding Cement… 

1.) Click on the symbol for Siliceous from the Tool Box Favorites List and the Cement field in the Rock 
Accessory Builder window will be filled in with sils [siliceous]. 

2.) Click anywhere within the existing Interpreted Lithology intervals, that you wish to insert the desired 
Accessory/Accessories. 

3.) Press the Esc key on the keyboard to exit from the Rock Accessory Builder window. 

Adding another Accessory… 

1. With the Rock Accessory Builder window activated click and drag the Accessory symbol you wish to move 
and drag the red box to the new location. 

2. Release the mouse button and the accessory or internal contact will be redrawn at the position. 

Moving an Accessory 

1.) Click and hold your mouse pointer down on the Accessory (see a red box) and drag to a new spot. 
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Deleting a single Accessory 

1. With the Rock Accessory Builder window activated right click (in the upper right corner) of the Accessory 
symbol you wish to delete and the pop-out menu will be activated. 

2. Click on the Delete selection from the pop-out menu and the selected Accessory 
symbol will be deleted. 

3. Press the Esc key on the keyboard to exit from the Rock Accessory Builder window. 

Deleting Multiple Accessories 

1. With the Rock Accessory Builder window activated Press and Hold the SHIFT Key 
and then click and drag an area where the symbols are that you want to delete. 

2. Release the mouse button and this will activate a message. 

 

3. Click on the  button. The accessories that were covered by your drag will be deleted. 
**Your log should now look like the log below.** 
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Adding a Cored Interval to the log 

1.) Double click on the Core track to activate the Well Core report window. 

 
2.) Type 1 into the Core # field. Tab key. 
3.) Type today’s date into the Coring Date field, using the Date Format (MMM DD, YYYY), selected in the 

System Options window at the beginning of this tutorial. Tab key. 
4.) Type 1213 into the Interval (From) field, Tab key, Type 1224 into the Interval (To) field, Tab key and Type 10 

into the Recovered field. 
5.) The rest of the fields can be filled in. Only the yellow fields are mandatory. Remember to Tab between fields. 

6.) Click on the  button. This will activate the Shortcut Options window. 

 

7.) Click on the   button. 

Adding Core Descriptions 

1.)  Click on the  button, in the Well Core window to activate the Core Description window. 



Power*Log Tutorial 2018 
 

Metric Tutorial   Page 37 

 
2.)  Type 1213 into the Interval (From) field, tab and Type 1218.4 into the Interval (To) field, tab and then Type 

Sh / mnr – abnt Ss strgs into the Rock Type field. Tab to get to the short description field. 
3.)  Type the following Core Description into the Short Description field, exactly as is:  

Sh lt gy, occly mot dk gy, micmica, v carb, slty, plty & fis. Occ tr Sid nods & unident fos 
deb. Ss strgs pred @ the top of zn, v thn <2 mm thk, s&p, vf gred, py srt, sbrdd, arg & tt / 
ns. 

Note: The Short or Long Descriptions can be added to the Lithology Description layer (in the Lithology 
Description track and only the Long Description will still be printed out in the Core Description Report in the 
Well End Report window. 
4.) Select the Automatic Transfer, Transfer Depth Range and Transfer Short Form check boxes , as shown 

in the preceding sample description window. 

5.) Click on the  button. 
6.) Depending on your Screen scale (>1:120) you may be prompted with a System Verification message  Click on 

the  button 

 

7.) Click on the  button from the ensuing Shortcut Options window. You will see your sample 
description on the log at 1213m with the options selected in step 4. 

 Adding another Core Description to a new interval… 
1.)  Type 1219.4 into the Interval (To) field, tab and then Type Ss into the Rock Type field. Tab to get to the short 

description field. 
2.)  Type the following Core Description into the Short Description field, exactly as is: 

s&p, m gred, w srt, sbrdd, qtz, cht, sils cmt, fr – g intgran por (16% - 18%), abnt brn o stng, 
bri yel flor, ex stmg yel cut flor. 

3.)  Click on the  button and then select  from the ensuing Shortcut Options window. 

Note: If you made any typing errors, you can make any necessary corrections now and then  the record once 
again to overwrite the old record. You must first delete the description from the Lithology Description Layer. 

 Adding yet another Core Description to a new interval… 
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1.)  Type 1221.4 into the Interval (To) field, tab and then Type Sh into the Rock Type field. Tab to get to the 
short description field. 

2.)  Type the following Core Description into the Short Description field, exactly as is: 

lt gy, occly mot dk gy, micmica, v carb, slty, plty & fis. 

3.)  Click on the  button and then select  from the ensuing Shortcut Options window. 

 Adding yet another Core Description to a new interval… 

1.)  Type 1223 into the Interval (To) field, tab and then Type Ss into the Rock Type field. Tab to get to the short 
description field. 

2.)  Type the following Core Description into the Short Description field, exactly as it appears below: 

s&p, m - vc gred, m srt, sbrdd - rdd, qtz, cht, tr sils cmt, g - ex intgran por (20% - 24%), v fri, 
v abnt brn o stng, bri yel flor, ex stmg yel cut flor. 

3.)  Click on the  button and then select  from the ensuing Shortcut Options window. 

 Adding the last Core Description to a new interval… 

1.)  Type 1224 into the Interval (To) field, tab and then Type No Recy into the Rock Type field. Click on the 

 button. This will expand the abbreviated Rock type into the Long name Rock type field. 

2.)  Click on the  button and then select  from the ensuing Shortcut Options window. 

Editing Core Descriptions 

1.) Make the Lithology Description layer active (in the Layer Selection List field), by clicking once anywhere 
within the Lithology Description track to highlight the Lithology Description track in green. 

 
1.) Click on the Core Description you wish to move. 
2.) Move your mouse pointer onto the bordered area on the lithology description track and so that the mouse 

pointer turns into  cross hairs and click and drag to move this description so that it can be read easily. 
Release the mouse button, and the Core Description will be moved to its’ new location. 

3.) Click anywhere outside of the area to take the focus off that annotation. 

Changing the Font Sizes over an Interval 

1.) Right Click anywhere on the lithology description layer. This will activate the pop out menu. 
2.) Select Change Properties (Range) and then Change Font Size selection. This will activate the Font Window. 
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3.) Select Arial, Regular and type 7 into the Font, Font Style and Size dialogue boxes and then Click on the 

 button. This will activate the Format Range Window. 

 
4.) Type 1213 in the Depth Interval from field and type 1225 in the Depth Interval to field and then Click on the 

 button. This will change the Font size from the default to 7-point Arial Regular font for the cored 
interval. 

Resize the Moved Annotations to fit the track width 
When annotations are moved or manually placed in an annotation layer, the user 
may want them fitting perfectly between the track edges. 

5.) Right Click anywhere on the lithology description layer. This will activate 
the pop out menu. 

6.) Select Resize to Track. This will activate the Format Range Window. 

7.) Accept the Depth Interval by Clicking on the  button. This will resize 
the annotations to fit the track width. 

Changing the Display Scale options 

            

1.) Click on 1221.4-1223m Ss Core Description. If done correctly the Core Description’s will show a highlight 
around the selected annotations borders. 

2.) To change the Display Scale of the Core Description now being displayed in the RFT Lines and boxes 
window, simply select All Scales from the display scale drop box to replace the 120. (When this is done the 
core description will display at all log viewing and printing scales.) 

Deleting Core Descriptions 
1.) Click on the Core Description you wish to delete to highlight it. 
2.) Right Click anywhere inside the annotation to activate the pop up menu shown below. 



                                    2018 Power*Log Tutorial 
 

Metric Tutorial   Page 40 

 
3.) Click on the Delete selection. 
4.) Click anywhere outside the annotation to close down the RFT Builders. 

Adding a Core Rate curve layer to the log 

1.) Under the Options menu, click on Log Configuration Builder or click on the  Log Configuration 
Builder button on the Toolbar to activate the Log Configuration Builder window. 

2.) On the left side of the Log configuration builder scroll down and highlight or click on the Curves track. 
This track has all of the curves available to our users except for mud gas curves, which are in the Mud logs. You 
can change names of any of the curve layers to represent any curve you wish but in our case all we have to do is 
follow step 2. 
3.) Click on the Core Rate layer in the layers portion of the window on the lower left side of the builder to highlight 

it. In addition, notice the Layers Radio button  on the left side is activated. 
4.) On the right side (Active Log) of the Log Configuration Builder window, click on the Drilling Progress 

track to highlight it. This is the track we want to add the Core Rate layer to. 

5.) Click on the  button and you will be prompted with the following system message, “Do you want 

to ADD the selected (layer) from the available log to the active log?” Click on the  
button. 

6.) This will activate a Get Name window with “Core Rate” as the name in the New Layer Name field. Click on 

the  button and the Core Rate layer will then be added to the Drilling Rate track. 

Note: The Core Rate curve has not yet been associated with the Core Rate layer. This will be done when the Add 
Curve window has been correctly filled in. 

7.) Click on the  button to return to the log and the log will be initialized with the new layer, which in turn 
will generate an Add Curve window. 

The Add Curve window… 

1.) Make sure the unit in the Curve Units field is correct (in 
this case it will be min/0.2m). If not, then please select 
min/0.2m from the Curve Units drop box field. 

2.) Make sure m is in the Depth Units drop box field. 
3.) Make sure the Null Value field is -999.25. 
4.) Make sure the Depth Interval is 0 and 0 indicating the 

present curve scale is applicable to any depth on the log. 
5.) Make sure the Curve Scale field values (Left / Bottom 

and Right / Top) to 0 and 10 
6.) Make sure the Backup Scale drop box field is Straight 

Shift. 
7.) Make sure the Grid type drop box field is Linear. 

8.) Click on the  button to add the Core Rate curve 
layer to the Drilling Progress Track. 

Importing an LAS Core Rate Curve 
1. Click on the File pull down menu selection and click on Import and then click on LAS from the pop out-menu 

or simply click on the  LAS button, on the Import Toolbar, to activate the LAS Reader window. 
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2. This will then activate the Open window which allows the user to select the LAS file you wish to import the data 

from. You can find the file in the PowerSuite_2018\System\Metric Core Rate Curve.las and highlight the file by 

clicking on it once and then click on the  button. You will see the window shown below. We will 
default to the importing of Curve data. 

 
Overview of window 

The left hand side of the LAS Reader window (shown on the right) allows the user to see the tree view of the data 
file format including the different data, parameter and definition blocks. The tree enables the user to select different 
sets of data or definitions. We have the choice to import these data types into the predefined 
data sets such as curves, Inclinometry, Tests, Tops and Core Data within the Power*Suite 
application. We default the window to select the log data or curve data if it is available  
The upper right hand side of the LAS Reader window (shown to the right) allows the user 
to see the data associated with the different data and parameters and definition blocks. 
The bottom left hand side of the LAS Reader window (Shown below left) displays the 
curve data sets that available to be imported. These can then be dragged to the import side 
of the LAS reader. 
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The bottom right hand side of the LAS Reader window (shown above right) shows the Import side displaying the 
Curve Layers and Curve names associated with the log that is open and active at the time the LAS Reader window 
was invoked. 

Importing LAS Curve Data files 
1. On the lower left side of the window Click and drag the Core Rate curve to the Core Rate layer on the lower 

right side and release it when the layer name becomes highlighted. 

N.B. The user can Right click on the Curve Layer ID to remove the mapping or switch the action from append to 
replace. The Symbol color will either be purple for replace or blue for append. 

2. Click on the  button. You will then be prompted with a system message after the import has finished. 

 

3. Acknowledge the Finished Import message. Click on the  button and then click on the  button 
to exit or click on the File menu and select the Exit option to close the LAS Reader Window. 

Adding Coring Times to the existing Drill Rate curve 
1.) Select the Drill Rate curve layer from the Layer Selection 

List field to make Drill Rate the active layer. 
2.) Double click on the Drilling Rate track to bring up the Curve 

Editor window for the Drill Rate curve layer. 
3.) Type 1214 into the Depth field. Press the Tab Key. 
4.) Type 31 into the value field. 

5.) Depress the Enter Key or Click on the  button. 
Note: Because the Auto Inc. field is set to 1, every time you enter 
a curve value the depth will increment by 1. Depending on the step 
of you curve you will reset this value when manually entering curve 
data. 
6.) Repeat Steps 4-5 to enter the Drill Rate values from the data 

below. 
7.) When you have finished adding values to the curve, click on 

the  button. 
 
 
 
 

1214 31 
1215 27.5 
1216 33.5 
1217 33.4 
1218 33.4 
1219 17.8 

1220 20.6 
1221 30 
1222 13.5 
1223 11.1 
1224 40.6 
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Changing Curve Scales in the Curve Editor window 

1.)  Click on the  button in the Curve Editor window. This will activate a Curve Scale window. We will 
be changing scales in our case at 1212m. 

2.)  Type in a different From Depth Interval changing the 0 to 1212 and then click on the  Button. This will 
activate a System message stating Record Saved Successfully. 

3.)  Click on  button. This will clear the window. 
4.)  Type in 1212 in the from depth interval field, tab, Type 3000 in the to depth interval field, tab, Type in 0 in 

the left / bottom scale field, Type in 60 in the right / top scale field, select strait shift from the Backup 
Scale drop box. 

 
5.)  Click on the  button and then select Exit from the ensuing Record Saved Successfully message box. 

6.)  Press the Esc key on the keyboard or Click on the  button in the Curve Editor window to exit from the 
Curve Editor window. This will return you to the main log and you will now be able to view your drill rate 
additions and the change of scale. 

**Your log should now look like the log below at 1:240 scale.** 
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**Your log should now look like the log below at 1:120 scale.** 

 

Adding a Formation Top 
1.) Click on Formation, under Reports, to activate the 

Well Formation window. 
2.) Type ab into the Formation Short name field, tab 

and Type Albequerqui into the Formation Long 
Name field, select Mesozoic from the Era Drop 
down box, select Lower from the Series Drop down 
box, select K [Cretaceous] from the Period Drop 
down box, and select Santonian from the Stage 
Drop down box. 

3.) Type in 1216 in the Prognosis TVD Top field, tab, 
type 1218.4 in the Sample Top (MD) field, tab and 
Type 1218.35 in the Sample Top (TVD) field. 

4.) Click on  radio button so the 
log will reflect the sample top. 

5.) Click on the  button and select  from the 
ensuing Shortcut Options window. 
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Draw the Interpreted Lithology (Please refer to the section on Drawing Interpreted Lithology earlier in this 
tutorial), for the Core Descriptions, that you have already created. Your Log should look similar to the log 
illustrated in the log below. To draw Lithology with the accuracy that has been described in the core 
descriptions you will want to change the accuracy of your mouse pointer or the screen scale accuracy to 
0.2m. To do this click on View menu selection, select screen scale accuracy and select 0.2 from the pop-
out menu. 

**Your log should now look like the log below at 1:120 scale.** 
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Adding Annotations 

1.) Click on the Drilling Rate track to make it active (highlighted in green). 
2.) Select Eng - Mud Parameters, as your active layer, from the Layer Selection List field. 
3.) Click and drag an area within the Drilling Rate track with the left mouse button depressed on the layer to 

define where the annotation will be viewed which will activate the RTF Toolbars. 

 
 

4.) Type the following into the text field in the annotation layer: 
FOB: 10-12K 
RPM: 50-70 
SPM: 95 
VOL: 1.4 

5.) To change the Font Color Highlight the Text you want to change by dragging the Mouse over the text to 
highlight the letters. 

6.) Click on the  button in the RFT Font toolbar. This will activate the color palette. 

7.) Click on the new color and then click on the  button. 
8.) Click anywhere outside the text box to save your annotation. 

Adding a Curve Fill layer to an existing log 

1.) Click on Log Configuration Builder, under Options, or use the Log Configuration Builder  button on 
the Toolbar to activate the Log Configuration Builder window. 

2.) On the left side of the window, click on the Curve fill track containing the Curve fill layer. 
3.) Click on the Curve Fill Layer, that you wish to add to your log, within the Layers section on the left side of 

the Log Configuration Builder window. You should notice the  radio button become activated 
4.) On the right side of the window, highlight the Drill Rate track so that you add the selected Curve Fill layer to 

this track. 

5.) Click on the  button to add the selected layer to the track on your log and the following system 
message will be activated, "Do you want to ADD the selected <LAYER> from the available log to the 
active log?" 

6.) Click on the  button to activate the Get Name window. 
7.) You now have the option of either renaming the layer or simply leaving it with its original name. Type in 

ROP/TG Curve Fill. 

Note: Two layers cannot share the same name. Accordingly, no layer will be added to your track if they share the 
same name as a layer that already exists on the active (your) track. 

8.) Click on the  button to add the layer to your log and place its name in the active Layers list on the 
right side of the Log Configuration Builder window. 



Power*Log Tutorial 2018 
 

Metric Tutorial   Page 47 

9.) Click on the  button to get out of the Log Configuration Builder Window. This should activate the 
Curve fill option window. If so skip to step 3 in the setup directions. 

Setting up the (2) Two Curve Fill options 

Once the layer has been added to your log the user can now utilize the curve fill layer. 
1.) To set the Curve Fill Options the user must first make the Curve Fill Layer active. To do so the user must 

Click on the Drill Rate Track containing the Curve Fill layer and then selecting the ROP/TG Curve Fill layer 
from the Layer Selection List field at the far left of the Selection Bar. 

2.) Double click anywhere within the Curve Fill 
or layer to activate the Curve Fill Options 
window. An example is shown on the left. 

3.) Click on the  button. This will 
activate a list of curves associated with this 
well. 

4.) Click on the Drill Rate and then click on the 

 button or double click on the Drill 
Rate Curve. You will now view the curve name 

below the  button. 

5.) Click on the  button. This will 
activate a list of curves associated with this 
well. 

6.) Click on the Total Gas Curve and then click 

on the  button or double click on 
the Total Gas Curve. You will now view the 

curve name below the  button. 

Curve Options Portion of the Window. This 
information is pertaining to the Main Curve and its 
Curve attributes. 

7.) Click on the Pattern Type down arrow and 
select the correct curve pattern for the main 
curve. The Drill Rate Curve is defaulted to PtoP 
(Point to Point). 

8.) Click on the Grid Type down arrow and 
select the correct curve grid type for the main curve. The Drill Rate Curve is defaulted to Linear. 

Fill Options Portion of the Window (2-Two Curves) 

9.) Click on the Fill Modes – 2 Curve down arrow and select the Fill Right of Main. 
10.) Click on the Fill Patterns down arrow and select solid foreground. 
11.) Click on the Foreground Color down arrow and select yellow. 

12.) Click on the  button. The Curve Fill Options window will close and the changes you have made will be 
shown on the layer. 

Layers Organizer 
The Layers Organizer allows the user to set priority to the layers that are in a track. Also allows the user to 
move a curves grid pattern up over top of others layers data. As you can see now the Curve fill takes 
president over the curve grid pattern. You can only organize the one grid at a time. 

1. Click on the Drilling Progress Track. It will highlight with a green outline. 
2. Select the Drill Rate Curve layer form the Layer Selection List. 

3. Click on Layers Organizer, under the View menu selection, or click on the  Layers Organizer button on 
the Toolbar to activate the Layers Organizer window for the Drilling Progress track. 
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The order of the layers on this list determines the order in which the layers are drawn on the track. The layer at the 
top of the list is drawn last and the layer at the bottom is drawn first. It's a good idea to put the most important 
layers nearest the top of the list, so that when drawn they are on the top. Remember that the active layer displays 
its grid pattern. 
The layers that are shown on the track are marked with a "Y", the hidden layers are marked with an "N", and the 
active layer is denoted with a ">". 

To show all layers, click on the  button. To hide all layers, click on the  button. To toggle a 

specific layer between show and hide, highlight the layer and click on the  button. You may also double 

click on a layer to change its current state. To make a layer active, highlight it and click on the  button. 

Moving the Grid for an Active Curve layer… 

4. Highlight the Movable Grid (associated with the Drill Rate Curve because it 

is the active layer) selection and click on the  button, which will 

then display,  
5. Click on the ROP/TG Curve Fill layer and the grid pattern will move above 

and the Movable Grid selection will then move one line above the selected 
layer. 

6. Click on the  button to exit from the Layers Organizer window. 
 
 
 
 
 
 
 
 
Note: You will have to repeat all the steps above to get the Movable grid associated with each curve above the 
ROP/TG Curve Fill layer. The Layers Organizer will only save data on exit. So you must exit after each layers 
moveable grid has been moved. 
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**Your log should now look like the log below at 1:240 scale.** 

 

How to Print the Log to a Printer Driver. 

1.)  Under the File menu, click on Print Log or click on the Print  button on the Toolbar to activate the Print 
Log window. 

Note: The Title bar and all depths associated with the Print Log window are defaulted to the Depth View that 
Power*Log is set to at the time of the activation of the Print Log window. 
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2.)  Select the letter portrait (because your log is 8” wide) from the Page Orientation drop box field and the 

Title Page, Legend, and Formation Tops will automatically conform to the selected orientation. 

Note: The selection of letter, legal or tabloid (landscape or portrait) settings from within this Print Log window will 
NOT override the paper orientation settings selected in the printer's Properties window. Therefore, you must also 
modify the paper orientation settings in your Printer setup Properties window to select the corresponding paper 
size and orientation. 
3.)  Activate the Dynamic Legend check box , if you wish to have the legend to reflect only the symbols printed 

on the log or core portions of the printed intervals defined in the log and core portions of the print log window. 
In the Log portion of the Print Log window 
1.)  Select 1:240 from the scale drop box for the log to be printed out at. 
2.)  Click to activate the Header and Footer check boxes  to print the track headers / footers on the log. 
3.)  Click on Lithology Section to highlight it in the printing options selection box. 

Note: The log itself must be displayed in whatever depth view you wish to print before you activate the print log 
window. To change the log to the desired format refer to depth view under the view pull down menu. 

Page Margin The page margin field is available, primarily, when you are printing to Adobe Acrobat writer. 
When a numerical value in inches is typed into this field it will initiate a top and left margin for the templates (Title 
Page, Legend and Formation Tops) as well as a left margin for the main log. 
Page Overlap Activate the Page Overlap check box  if you are printing on single sheets. This will force the 
printer to include an additional 1/4 inch of the log at the top and bottom of each page, so that you can cut-and-paste 
pages manually, if you so desire. 
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Print Methods… 
Default Activating the Default radio button  forces Power*Log / Curve / Core to use a raster or bitmap graphic 
printing method. This printing method is generally used with Laser printers but not exclusively so. 
Meta File Activating the Meta File radio button  forces Power*Log / Curve / Core to use the meta file 
technology printing method. This printing method was developed for the newer models of printers on the market 
today as well as using the Adobe Acrobat Distiller or pdf printing technology. 

Color Options… 
Auto Activating the Auto radio button  forces Power*Log / Curve / Core to use the settings from the printer 
driver to printout the log. 
Color Activating the Color radio button  forces Power*Log / Curve / Core to override the printer driver settings 
and consequently Power*Log / Curve / Core assumes that you are using a color printer. 
Mono Activating the Mono radio button  forces Power*Log / Curve / Core to override the printer driver settings 
and consequently Power*Log / Curve / Core assumes that you are using a monochrome (black and white) printer. 
Interval per page field indicates how many meters of log will fit on a page of selected paper size and orientation 
selected in the setup as well as what log scale you are printing at. This will help indicate to the user how many 
pages will be required by the print job. 
1.)  Click on the Core Section 1213-1224 Core 1 to highlight it. 
2.)  Select the Core log scale of 1:48 and the Core Track Header and Footer check boxes . 

3.)  Click on the  button to activate the Print Setup window and confirm that the correct printer settings 
are in effect. 

Note: If you are printing out logs in color, you must activate the Diffusion or Error Diffusion option normally 
found under Graphics in the Properties window for most printers. 

4.)  When you are ready to print your log, click on the  button. 

Note: If you do exit from the Print Log window, you will be asked if you wish to save the print settings. If you click 
on Yes, the program will remember every setting that you made to the Print Log window and then will default to 
those settings the next time you enter the Print Log window. 

How to Print the Log to a TIFF (file format) 

Prints all or part of your log/well along with the Title page, location map, legends, survey views, 
individualized cores and formation tops on a continuous basis in a tiff file format. 

1. Under the File menu selection, click on Print to TIFF or click on the  Print to TIFF button on the Toolbar 
to activate the Print to TIFF window shown below: 

Note: The depth views associated with the Print TIFF window are defaulted to the Depth View that Power*Log / 
Curve / Core is in at the time of the activation of the Print to TIFF window. 
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2.  Select letter Portrait from the drop box field for the Title Page, 
Legend, Tops, Survey Views and they will automatically conform to the selected orientation. There are four 
(6) types of paper orientation to choose from. But your log is 8” wide so letter portrait is the page orientation. 

3.  Select this check box , to printout a Title Page. 
4. The Type (Title Page) drop box displayed on the right allow you to pick the appropriate title 

page format to print. Select standard to prints out our full blown title page with most of the 
Wells data. 

5.  Select the AER UWI format for the Title page as the well is in Alberta. 

N.B. This format changes our UWI printout from 100121605812W500 to 00/12-16-058-12W5/0 only on the Striplog 
Title page. All other UWI formats (DLS and NAME) remain the same. 

6. Activate this check box , if you wish to printout a logo, and then select a logo from the Logo 
drop box field. 

Note: The logo file format must be a bitmap image file (*.bmp) if you want a logo printed out on the title page. Also, 
it is recommended that the bitmap image should be a square image, because Power*Suite will shrink or expand 
the image to fit the logo space on the Title Page. This bitmap must be placed in the Powersuite_2018\LOGO 
directory for the application to find it. 

7. Type any pertinent comments into the Title Page Remarks field and they will be displayed accordingly on the 
Strip Log Title Page only. 

8. Deselect the  check box. In our Case we do 
not have a location map so deactivate this check box . If you wish to printout a location map following the 

title page, and then the user select a location map from your computers drives by clicking on the  and 
finding the file you want to print out as a location map. 

Note: The location map file format must be a bitmap image file (*.bmp) if you want a location map to be printed 
out. Also, the bitmap image must be a square image, because Power*Suite will shrink or expand the image to fit 
the location map space following the Title Page. This bitmap can be placed anywhere as the file location is saved 
within the Power*Suite initialization file. (pgeology.ini) 

9. Deselect the Survey views  check box. 
10. Deselect the Survey views  check box. 
11. Deselect the Survey views  check box. 
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12. Deselect the Survey views  check box. 
13. Deselect the Survey  check box. 
14. Select the  to activate this check box . 
15. Select the  to activate this check box , because we want the legend reflect only the symbols 

printed on the log or core portions of the printed intervals defined in the log and core portions of the print log 
window. 

In the Log portion of the Print Log window 

16.  Select 1:240 or type in the 
Scale for the main log to be printed out at, in 
the Scale drop box field. 

17. Select  to activate this 
check box  to have the track headers 
/footers printed out with the main log. 

18. Select  to activate this check 
box  to have the core accessories printed 
out on the main log. 

19. Select the defined interval. Type in 1188 and 1226 in the from and to fields. 

Note: The log itself must be displayed in whatever depth view you wish to print before you activate the print log 
window. To change the log to the desired format, refer to depth view under the view pull down menu. 

In the Cores portion of the Print Log Window 

20. Highlight Core 1 highlighting them. 
21. Select 1:48 or type in the Scale for the core log to be 

printed out at in the Scale drop box field. 
22.  Activate this check box  to have 

the track headers / footers printed out with the core 
log. 

Note: A separate Header Information Box is automatically printed out with every Core and includes the Core 
Scale, Core Date, Core Number, Cored Interval, Amount Cut, Amount Recovered, and Percentage. 

23.  Activate this check box  if you wish to printout Formation Tops and the Formation Tops will be 
included on a separate page at the end of the log printout. 

 The page margin field is available, primarily, when you are printing to Adobe Acrobat writer. This is not 
necessary for printing to tiff file format 

24. When you are ready to print your log, click on the  button. 

25. This will activate a message box indicating the size of your printout. Click on the  
button. 

26. This will activate a file name window to be filled in with a file name and location to where 
you can locate it for further reference. 

Note: If you do exit from the Print to TIFF window, you will be asked if you wish to save the print settings. If 
you click on Yes, the program will remember every setting that you made to the Print to TIFF window and then 
will default to those settings the next time you enter the Print to TIFF window 

Adding a Link (Attachment) to your Log 

1.) In our case Right Click on the Lithology Description layer to activate the pop out menu. 
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2.) Select Add / Edit / Open Link from the pop out menu. This will activate a blank Links window with the depth 
you right clicked at. 

3.) Click on the  button in the Links window and you can now pick any windows compatible file. In our case I 
am linking the printed well file from the next section of the tutorial printed to my backup folder and then click 

on the  button. This will fill in in the details of the File Name and location in this window. 

    

4.) Now the user can Type in some remarks to tell the viewer what the file is (if the user would like to identify the 

file) and then click on the  button. This will activate the Shortcut Options Window. 

 

5.) Click on the  button. This will insert the paperclip symbol  where you originally right clicked and link 
the file to the log. 

This concludes the Power*Log Tutorial. If you need help with specific functions or operations, 
please use the Table of Contents in the Power*Suite User Manual to find the desired topic or use 
the Search function built into the On-line Help. 


